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What’s New 
 
Impact 2010 has full support for a dedicated Customer Contacts table – containing fields for contact name, 
title, job title, email, telephone number, mobile telephone number and fax number.  As with most Impact 
database tables, Customer Contacts may be customised further by the addition of extra fields & tabs. 
Impact 2010 has support for active & inactive customers – inactive customers are ‘hidden’ preventing new 
projects from being assigned to them, whilst their data and assigned projects are still available (user-
privileges allowing).  This concept may also be applied to external Customer databases. 
Extending the Site-Specific functionality which was introduced with Impact 5, Impact 2010 Customers and 
Projects may now be classified as Site-Specific.  This means that customers may be allocated to specific 
database sites and projects may be filtered by which site they were created at. 
User passwords may now be encrypted for added security.  If this option is applied, no potentially sensitive 
passwords are stored as regular text within the Impact database. 
Separation of database schema alteration & Impact users now allows database structure changes to be 
carried out via a client-server database ‘front-end’, as opposed to Impact directly.  This reduces the time 
taken to restructure databases – especially useful for restructuring large databases containing many 
projects. 
Active-X Data Object support for external customer tables.  External customer databases can now benefit 
from ADO connections, as opposed to ODBC connections only. 
Active-X Data Object support for Oracle databases.  
Improved Customer-Name caching.  Internal changes have improved the response time when caching & 
displaying customer names within the Impact Projects Browser and the Project Information customer list. 
Dual-Unit Support for Dieboard, Blanker & Stripper Tools.  Switching between Metric & Imperial units will 
give sensible default values. 
 
A number of new features were developed late in the Impact 5 product lifecycle – it is anticipated that the 
majority of Impact users will not have been exposed to these features.  These features include 
A new Layer-Revision mechanism has been developed, allowing designers to retain or increment layer 
revision numbers, allowing layer-based (as opposed to project-based) revision control.  This means that an 
individual drawing layer can have revisions.  Although this mechanism was developed late in the Impact 5 
product life-cycle, it is anticipated that the majority of Impact users will not have seen this feature. 
A new Auto-Save option has been added – allowing a choice of auto-saving to the database or to a local 
folder.  As an enhancement of this feature, an Auto-Recovery mechanism has been developed, allowing 
Impact to recover auto-saved files in the event of an unexpected program termination.  
Wide Area Network Performance Improvements – thumbnail images, design components, symbols & 
templates and certain database queries can now be cached locally, as opposed to streaming them from the 
database whenever they are used. 
Optional Terminology for Print/Die Face and Flute/Grain directions – users can decide which terminology 
options they would like to deploy.  This will affect the details displayed on the Utilities>Face Settings dialog 
as well as the Help Tips for the Direction Indicators.  
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Customer Contacts 
A new customer contacts mechanism has been developed, offering significantly more features & data options 
than the current Customer database implementation offers.  For the Impact 2010 Release database, this feature 
will be available straight away.  A new database window (Customer Contacts) will be available from the Actions 
button on the Customer database window. 
 

Contacts option on the Customer Database Window 

 
 

Customer Contacts Database Window 

 
Note that contacts also have an Active property!  The contacts themselves are stored in a new CONTACTS 
database table, which is added by default during the upgrade to existing Impact installations, and is present in 
the default Impact 2010 Release database. 
Customer Contacts may be added, modified, found & deleted in the usual manner, subject to user privileges.   
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Customer Contacts User Privileges 

 
Currently, the associated Database Window for the CONTACTS table must be installed manually.  The database 
setting will therefore be made available to both new & existing Impact users upgrading to Impact 2010. 
 
Note that if you wish to link a customer contact to an Impact drawing, you’ll need to modify the DRAWINGS 
table (add an INTEGER type field – the name D_CONTACT would make a logical choice): 
 

Suggested D_CONTACT Field 

 
You will also need to modify the Standard Drawings Database Window (DBW) to include a Dynamic Lookup to 
the CONTACTS table, as follows. 
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Suggested Dynamic Lookup for CONTACTS Database Window 

 
 
The Local Filter field D_CUSTOMER and Foreign Filter field CC_CUSTKEY will allow only contacts for the current 
customer to be displayed (records for which D_CUSTOMER will match CC_CUTKEY).  The addition of the Filter 
SQL allows only Active contacts to be displayed. 
Points to note: 

• For Impact 2010 upgrades, a basic DBW (containing the Contacts database window) will be made 
available.    

• The actual table structure will be imported when upgrading the database as the ADMIN user. 
• For Impact 2010 upgrades & new installations, the new database window must be specified within the 

Database Operation settings for users or user groups who need to use these feature.   
• For upgrades to existing Impact installations, the existing CUSTOMER.CS_CONTAC1, 

CUSTOMER.CS_CONTAC2 & CUSTOMER.CS_CONTAC3 fields may be hidden from the Standard 
Customers Database Window. 

• Scripts or macros may be used to ‘pump’ the existing CUSTOMER.CS_CONTAC1, 
CUSTOMER.CS_CONTAC2 & CUSTOMER.CS_CONTAC3 data into the new CONTACTS table and assign 
them to the correct CUSTOMER records. 

• Scripts or macros will be needed to display the linked Contact data on a border plot. 
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Active & Inactive Customer Support 
Many end‐users have asked about the feasibility of ‘archiving’ their Impact customer records. Typically this 
means deleting customer records which they no longer feel are necessary to keep (for various reasons).  Prior to 
Impact 2010, this would typically have involved re‐assigning or deleting projects belonging to those customers 
and then deleting the customer records, or simply exporting a DTS file containing the projects which belong to 
the customers to be ‘archived’ (and then deleting the customer records).  Both methods have major 
disadvantages and with the recent advances in data storage technology, high capacity & high speed storage 
media render the space‐saving argument obsolete.   In light of the constant requests for a workable ‘archiving’ 
solution, Impact 2010 now supports the concept of active & inactive customers.  Any customers flagged as 
inactive will not be able to have new projects assigned to them ‐ they will not appear in the Customer list when 
project information is being displayed for new projects or appear in the customer list at the Saving Projects 
dialog.  Customers are simply marked as active via the Customer database window and may be re‐activated at 
any time.  This solution means that no customer records need to be deleted – and no projects need to be 
deleted or re‐assigned. 
 

Customer Database Window showing the Active flag 

 
 
Inactive customers (and associated projects) may be viewed in the Projects Browser provided the new ‘View 
Inactive in Browser’ privilege has been granted to a user or user group 
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View Inactive in Browser User Privilege 

 
Because of the complexities associated with this functionality, the active\inactive customer support will not be 
available as an automatic update – this will need to be configured manually during a software update – if the 
feature is required by the customer.   
 
A BOOLEAN type field will need to be added to the CUSTOMER table (CS_ACTIVE, may be left empty in database 
windows, ‐ a value of 1 signifies an active Customer, whilst a value of 0 signifies an inactive customer). The 
CUSTOMER database window will need to be modified to include this field.  
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CS_ACTIVE field attributes 

 
 

Active & Inactive Customers in the Projects Browser 
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Points to note: 
• Note that this feature must be configured manually by the support engineer. 
• Note that once this field has been added to the database, all existing Customers will be initialised 

as inactive.   
• The Impact engineer carrying out the upgrade will need to run a suitable SQL statement on the 

Customers table to re‐activate the existing customers.   
• A statement such as update customer set cs_active=1 where cs_key>0 should be sufficient.   
• Setting the default value in the Standard Customer database window to Value, True ensures that 

all new customer records will be active by default. 
• Currently, customers may only be switched between active & inactive via the Impact user interface 

on a ‘one customer at‐a‐time’ basis. 

Active & Inactive Customer Support for External Customer Databases 
This feature has also been extended to External Customer Tables.  The field used to signify an active customer 
must be a Boolean (with a value of TRUE) or a Character column (with a value of ‘A’). 
 

Site‐Specific Customers 
One of the major developments for Impact 5.1 was the concept of site‐specific Master Tool Settings.  This 
concept was developed as more & more customers began to look at the possibility of multiple sites (design 
and/or manufacturing centres) connecting to a single, centralised Impact database.   
These developments meant that a single Impact database can contain several ‘Sites’ and each site may be 
assigned specific Users and Master Tool Settings.  Consider a single Impact database, hosted in a data 
warehouse in Central Europe.   This database may be accessed from a site in the UK and a second site in the 
USA.  Site‐specific Master Tool Settings means that only plotter machines actually housed at the UK site can be 
seen from the plot dialog for users assigned to the UK site.  Most Master Tool Settings are capable of being site 
specific   (Border Plot Settings, User Settings, Standards Materials etc).    
Assuming the Database Installation option Sites has been enabled and actual Sites created in 
Database>Administration>Sites, customers may now be linked to specific database sites.  To make use of this 
feature, the Database Installation> Sites>Customers option should be enabled.  Note that this feature is not 
implemented for external customer databases.  
 

Customers may be assigned to sites via the Customer DBW>Actions>Sites. 
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Site‐Selection Dialog 

 
Essentially, once a customer is linked to a site, users belonging to that site may assign projects to it via the 
Project Info dialog, via the Save As dialog and also via drag & drop in the Browser.  Note that a user privilege has 
been added to allow members of a user group to assign customers to sites. 
 

Assign Customers to Sites User Privilege 

 
  

Points to note regarding site‐specific customers:  
• A single customer may be assigned to multiple sites.   
• Any customers not assigned to a site will be visible to all Impact users.  
• A new database table (CUSTSITE) holds the site data and the link between Customers and Sites. 
• Currently, customers may be assigned to sites via the Impact user interface on a ‘one customer at‐a‐

time’ basis. 
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Project‐Site Assignment 
On a similar theme, projects may also be assigned to sites.  To make use of this feature, the Database 
Installation> Sites>Projects should be enabled and the SITE field should be added to the Browser details.   
 

Projects Browser Showing Site Field 

 
Points to note regarding site‐specific customers:  

• This development is purely to allow projects to be filtered by sites in the Browser.   
• Projects created by a user, who has an existing site assignment, will be assigned to a site.   
• This feature will not lock‐down projects to a specific site. 

Reporting on Site‐Specific Items 
From the Sites node within Database Administration, a context menu is available, allowing you to display the 
details of the site‐specific items within the database.  Right‐click on the Sites node and pick Report to generate 
a report for all sites.  Right‐click on a specific site and pick Report to generate a report for a specific site. 

Example Site Report Preview 

 
Concise details may be displayed by simply selecting the Sites node itself: 

 
 
 
 
 



 

    
Impact 2010 Database  © Copyright 2010  Arden Software North America  P a g e   13 | 23 

 

At‐A‐Glance Site Contents 

 
A right‐click on a specific site will allow a report to be generated for that specific site only. 
 

Encrypted User Passwords 
Traditionally, the Impact user account passwords have been stored as plain text within a database table.  As 
users may be inclined to use the same password for several applications (web sites, bank accounts etc), steps 
have been taken to ensure that someone with Impact database access cannot acquire a list of these passwords.  
Similarly, server passwords (for client‐server databases) will also be disguised. 
An automatic update is available (when connecting to the database as the ADMIN user) to encrypt the user 
passwords.   
 
             Encrypt User Passwords Automatic Update 

 
If this update is activated, a warning message will be displayed explaining that: 

• The USERS database table will be restructured. 
• That all passwords in this table will be encrypted. 
• This action will be irreversible. 
• It will be impossible to recover the original, unencrypted passwords.   
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Once the encryption has occurred, the passwords will be stored in an encrypted format which will display a 
seemingly random string of characters (when viewed with tools such as DbDaemon, SQL_Explorer or 
SQL_Server Management Studio). 

Points to note: 
• Post encryption, new passwords will be case‐sensitive. 
• In the case of a user forgetting their password, the Impact DbClean utility may be used to re‐set the 

password to a hard‐coded character string (ChangeMe).  This is sufficient to allow the user to login and 
re‐set their password. 

• This development will not affect existing passwords – simply the way they are stored with the Impact 
database. 

Separation of Schema Alteration & Impact users 
Immediately after an Impact upgrade, it is normal practice to connect Impact to the database logged in as 
ADMIN.  This action causes Impact to check the structure of your database and inform you if there are required 
modifications (such as new tables and columns to be added). When prompted, it is important to restructure the 
database in order for Impact to function correctly.  
In the past there was only one way to do this restructuring ‐ to allow Impact to make these changes directly to 
the database.  Now you have the choice to allow Impact to detect the changes and generate an SQL script which 
you can view and apply to the database independently of Impact. 
 

Database Structure Changes dialog 

 
The new Operation pull‐down list has the following choices:  

• Apply changes directly to database (recommended). 
• Script database changes to text file. 
• Apply changes to data dictionary. 

 
 



 

    
Impact 2010 Database  © Copyright 2010  Arden Software North America  P a g e   15 | 23 

 

Apply changes directly to database 
This is the usual way of applying database structure modifications. It remains the recommended method for 
administrators who don’t have any special need to generate scripts.  
On pressing the Continue button, Impact applies the changes directly to the database. No further action is 
required. 

Script database changes to text file 
Choosing this option and pressing Continue will cause Impact to generate a SQL script and prompt you for a 
location to store it.  
You should see the following message: “Successfully exported the database changes. Once you have applied 
these scripted changes to your Impact database ensure you re‐import the changes and update Impact's 
database dictionary to match the physical database structure. Failure to do so may result in Impact generating 
invalid SQL statements and/or reporting database errors.” 
The file may be viewed in any editor. If you attempt to modify the script, you should take extreme caution and 
you should back up the database before applying it.  
You should now exit Impact and not restart until you have run the script on the database.  

Apply changes to data dictionary 
This option must only be used if you have already generated a script, as described above, and applied it.  
In these circumstances, the Database Structure Changes dialog will not normally be displayed, so you must 
manually initiate this process. When logging in to Impact as ADMIN, it is best to skip the Database Integrity. Use 
Database > Administration and from the menu choose Tables > Import > Table Description. You must then 
locate the DBS file which describes the necessary database structure (this is normally called “ipds_ddb.dbs” and 
often resides in the Impact program folder). 
When you press Continue, Impact updates its database dictionary without affecting the database itself. This is 
normally a very quick process. On completion, you will see the message “Successfully updated Impact's 
database dictionary. It is recommended you perform an Integrity Check from the Database Administration 
dialog to verify the database against the dictionary”.  

The generated scripts 
The script text is dependent on the primary database type (SQL Server, Oracle or MySQL). 
The script produced for SQL Server uses a temporary table and transaction to rollback any changes on failure. 
Oracle and MySql scripts just contain the SQL statements. 
 
The following walkthrough adds a simple CC_TEST field to the CONTACTS table for an SQL_Server Express 2008 
R2 database.   

• The source database contains a modified table – in this case, CONTACTS.CS_TEST. 
• A DBS file is exported containing the changes to this table. 
• The DBS is imported into the destination database – but the option to Script database changes to a file 

is chosen. 
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Impact‐Generated Script 
 
‐‐ Impact Scripted Database Changes 
‐‐ Generated on 05/07/2010 12:52:05 for Microsoft SQL Server 
‐‐ Please back up your database before running this script 
 
‐‐ After applying these scripted changes to the Impact database you must reimport the changes and update Impact's 
database dictionary to match 
‐‐ Failure to do so may result in Impact generating invalid SQL statements and/or reporting database errors 
 
IF EXISTS (SELECT * FROM tempdb..sysobjects WHERE id=OBJECT_ID('tempdb..#tmpErrors')) DROP TABLE #tmpErrors 
GO 
CREATE TABLE #tmpErrors (Error INT) 
GO 
SET XACT_ABORT ON 
GO 
SET TRANSACTION ISOLATION LEVEL SERIALIZABLE 
GO 
BEGIN TRANSACTION 
GO 
 
PRINT 'Modifying Table CONTACTS' 
GO 
ALTER TABLE dbo.CONTACTS ADD CC_TEST VARCHAR(10) 
GO 
IF @@ERROR<>0 AND @@TRANCOUNT>0 ROLLBACK TRANSACTION 
GO 
IF @@TRANCOUNT=0 BEGIN INSERT INTO #tmpErrors (Error) SELECT 1 BEGIN TRANSACTION END 
GO 
 
IF EXISTS (SELECT * FROM #tmpErrors) ROLLBACK TRANSACTION 
GO 
IF @@TRANCOUNT>0 BEGIN 
PRINT 'The database update succeeded' 
COMMIT TRANSACTION 
END 
ELSE PRINT 'The database update failed' 
GO 
DROP TABLE #tmpErrors 
GO 

• The script is then copied & pasted into the Management Studio application hosting the database to be 
modified – then executed. 
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Applying the Script to the Destination Database 

 
 

Successful Script Execution 

 
 

New Field is Visible (After Reconnection) 

 
 

• Note that although the new field has been added to the database and is currently visible through the 
Management Studio application, it is not visible within Impact itself.  Hence the requirement to update 
the Impact data dictionary. 
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Updating the Impact Data Dictionary 
• The DBS file generated by the source installation is then used to update the data dictionary. 
• Use Database > Administration and from the menu choose Tables > Import > Table Description. 

 
Successfully Updated the Impact Data Dictionary 

 
Points to note: 

• The ‘apply changes directly to the database’ option is still the recommended option. 
• The scripting options are aimed at Impact database administrators who need to modify Impact 

databases externally via 3rd party tools. 

Oracle ADO Driver Support 
Impact now supports ADO connections to an Oracle database.  In the same way that and SQL_Server data 
connection is slightly quicker to set up & slightly easier to maintain than an ODBC connection, the same benefits 
are offered by ADO support for Oracle.  

ADO Driver Support for External Customer Databases 
You can now choose to use an ADO connection for External Customer Databases. 
 

External Customer Database dialog showing ODBC & ADO options 

 
This offers the same ease‐of‐use and easy setup options as previously mentioned. 
 

Improved Customer Name Caching 
Internal code changes have improved the response time when caching customer names within the Browser and 
also displaying the Customer list within the Project Information.  There is nothing to configure to take advantage 
of these improvements. 
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Dual Unit Support for Dieboard, Blanker & Stripper Tools 
The unit duality concept has been extended to these tools – there are no user options needed to make use of 
this feature.  Switching these MTS from metric to imperial will give sensible default values. 
 

Layer Revisions 
New options have been added to allow users to increment or retain layer revision numbers independently of 
Project Revision numbers.  This means that a designer may choose to retain a layer revision number (in the case 
of a non‐structural design change) or increment a layer revision number in the event of a structural design 
change.  A movie demonstrating this feature has already been published at www.impactcad.net  (search for 
Layer Revisions in Tutorials only). The new options are enabled here: 
 

Layer Revision Controls 

 
The new options for updating/retaining layer revision numbers are displayed here when updating a project: 
 
        Layer Revision Update Options 
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When viewed from within the Project Browser, the Layer Revisions now have a context menu (allowing 
access to the layer revision details, quick opening of project, full‐screen preview, layer database 
information, make (layer) current option and compare (with current revision)) and the layer revisions 
themselves are displayed in the preview pane: 
 

 
 
Points to note: 

• The real advantages of the layer revision mechanism become apparent when working with multi‐layer 
projects.   

• Prior to Impact 2010, reverting to a previous Project revision in order to reverse some geometry 
changes in one specific layer would affect the entire project – the entire project would be rolled back 
to the revision level.   

• With the new mechanism in place, you simply need to roll‐back the specific layer, leaving the 
remaining project layers unchanged. 

• This functionality will be available immediately following an Impact 2010 install or an upgrade to an 
existing Impact setup. 

Auto‐Recovery 
This development appeared during the late stages of the Impact 5.1 roll‐out and may therefore be familiar to 
certain Impact users.  The idea behind this functionality was to provide an auto‐recover tool which would 
restart Impact after a failure (and where possible, detect that a possible failure is about to happen and warn the 
user accordingly) and a method by which any projects which were open during the failure could be salvaged.  
Impact will now allow users to auto‐save files to the database OR to a local temporary file location (the 
Autosaves folder within the defined Impact Temp directory). The latter option counteracts the effect of a 
database or networking failure as well as providing the opportunity to rescue (recover) the drawings that were 
open during the failure.   
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Autosave Options 

 
If Impact detects a potentially fatal error, a warning will now be delivered to the user, allowing the opportunity 
to restart the application (and recover any locally auto‐saved files). 
 

Fatal Error Dialog 

 
 
Critical errors will allow the user the opportunity to continue the current Impact session or restart the 
application (and recover any locally auto‐saved files). 
 

Critical Error Dialog 

 
Upon an automatic restart, the following dialog box will be displayed and Impact will attempt to auto‐recover 
any files saved locally. 
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Automatic Recovery Dialog 

 
The auto‐saves folder will be cleared each time Impact closes successfully – this will prevent a large build up of 
temporary drawings. 
Points to note: 

• Auto‐recovery of drawings will only take place if the ‘Save locally’ auto‐save option is used. 
• When a project is auto‐recovered, the project name will be displayed as ‘Recovered auto‐save of 

XXXXXX’. Users should use the File>Save As options to provide a suitable project name. 

WAN Performance Improvements 
Additional caching options have been added to the Database Connection Advanced tab.  These offer 
performance increases by caching thumbnails (used within the Browser, the Standards Browser and the Design 
Component Library), component files (Standards, Design Components, Symbols & Templates) and certain 
database queries (for re‐use) locally. 
 

New Caching Options – Database Connection Advanced tab 

 
Enable these options to boost performance over wide area networks.   
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Points to note: 
• The Advanced tab may be accessed via Options>Environment>Workstation>Database Connections. 
•  Certain end‐users may not have the required privileges to access the Advanced tab via the above 

route. 
• In this case, the Advanced tab may be access via the Connection Manager for all users. 
• An additional document is available describing how to optimise Impact over a WAN. 

Optional Terminology for Flute/Grain Direction 
Prior to Impact 5SP4, Impact was hard coded to use terms such as ‘Flute Direction’, ‘Print Face’ & ‘Die Face’.  
The new Terminology option available within the Database Operation node allows users to pick the terms they 
would prefer to use for Faces & Flute/Grain direction:  
 

New Terminology Options – Database Operation>Terminology Node 

 
These options may be specified in a Database Operation by an Impact Administrator if required.  These options 
will affect the details displayed on the Edit Bar, within the Face Settings dialog and within the Help tips 
displayed over the direction indicators (plus other places!). 
Points to note: 

• The ability to select the required terminology is governed by user‐privileges.   
• End‐users may not have the required privileges to access the Database Operation settings. 
• The Impact Administrator may need to set these options at a Master Tool Settings level for certain user 

groups. 
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Impact 2010 Layouts 
What’s New? 
The Impact 2010 Layout Creator has been overhauled in an effort to replicate a real-world workflow. 
New tools have been added to allow better utilization of available resources (machines & sheets), whilst 
certain tools have been repositioned within the Layout Editor reflecting their importance.   
The new Force Extra Row/Force Extra Column tools may be used to add extra One_Up designs to a layout 
(where applicable) and the new Layout Trim tool will allow overlapping designs to be trimmed against each 
other once a layout has been completed. Over long production runs, an extra row or column of designs on a 
layout may provide a significant material & cost saving. 
The new Trim Optimisation tool allows you to utilise the maximum diecutting area of a machine where 
applicable – again saving materials & costs. 
The default database used for new Impact 2010 installations will contain settings for a wide range of Bobst, 
Iberica, Heidelberg, Sanwa & Emba machines. These settings will be made available to existing Impact 
installations when upgrading to Impact 2010. 
A new Quick Layout tool has been developed to allow quick access to key parts of the Layout Creator 
functionality, whilst dispensing with the additional user interface options.  The result is a streamlined tool, 
ideal for users who do not need every last ounce of the Layout Creator functionality. 
 

Layout MTS – New Settings & Modifications 
Traditionally, the Machine/Sheet Settings have represented either a machine (whereby the size & trim values 
represent the physical limitations of the machine) or a sheet where the sheet size is known (pre‐cut stock 
board, effectively).  In the case of stock sheet, the trim value is irrelevant as the sheet could be loaded on 
different machines, each having different trim values. 
This has led to the creation of a dedicated Stock Sheet Setting MTS category (within the MTS Layouts folder), 
which contains only controls Name, Description, and Width & Height & Flute/Grain direction.  These settings are 
purely for representing stock board – the layout tools will function without them and so you do not need to add 
‘dummy’ settings to this folder if you do not use stock board!   
 

Stock Sheet MTS 

 
 
The Machine/Sheet Settings MTS have been modified by the addition of many new features.  The Width, Height, 
Trim & Flute/Grain properties remain (note that the preview has been updated with labels for Sidelay, Offlay, 
Grip Edge & Back Edge) –and these attributes are to be found on the Standard Sheet tab. 
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Machine/Sheet Settings Standard Sheet Tab 

 
These functions remain unchanged from previous Impact versions. 
 
The Machine Limits tab allows users to utilise several new features – Minimum sheet size (attempting to create 
a layout smaller than the minimum sheet size of any machine will display a warning to the user), Maximum 
diecutting area and  Allow trim optimisation plus rounding options for fitted sheets (so that fitted sheet sizes 
may give ‘sensible’ values).   

Machine/Sheet Settings Machine Limits Tab 

 
 

The Allow trim optimisation option allows the trim to be reduced to the exact width & height specified, and is 
linked to a new layout tool (Use Minimum Trim ‐ available within the Layout Editor itself).  If Allow trim 
optimisation is not enabled for a machine, the Use minimum trim tool will not be available within the Layout 
Editor unless a temporary override is made.  This option will be default to off for upgrades to existing Impact 
installations. 
 
Whilst the Standard diecutting area may be considered to the maximum/default sheet size less the trim values, 
the Allow trim optimisation option allows you to use the defined Maximum diecutting area of the machine –
encroaching on the standard trim. This is ideal when the required layout is fractionally larger than the sheet.  
The Minimum sheet size and Maximum diecutting area values have been taken from the relevant service 
manuals for the specified machines. 
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Machine/Sheet Settings Machine Type Tab 

 
 

The Machine Type tab allows the user to specify which type of material a machine may be used for and whether 
the machine is a flatbed or rotary type and the maximum & minimum calliper values supported by the machine.  
There is also an additional ‘Sheets per hour ‘field – though this feature is currently unused.   
For Impact 2010 upgrades to existing Impact installations, the additional distance type fields (on Machine Limits 
& Machine Type tabs) will default to zero and any optional new features (Allow trim optimisation & Folding 
Carton/Corrugated machine types etc) will be switched off. 
Two new Layout Pattern Settings have been added to the default Impact 2010 Release database (End to End 
and Tapered).  These settings may be distributed for Impact 2010 upgrades to existing installations. 
Two new Layout Palette Settings have also been added to the default Impact 2010 Release database (Fitted 
with Print and Stock Only).  The former setting simply adds a print pattern border around the One_Up designs 
and will use the Sheet Print Area palette by default.  The palette itself is not new for Impact 2010!  The latter 
pattern simply adds the stock sheet geometry to the layout.  Both settings are available for Impact 2010 
upgrades to existing Impact installations. 

Layout Sheet Assistant 
Upon launching the Layout Creator, the Layout Sheet Assistant is displayed.  This tool simulates a real‐life 
workflow and is designed to facilitate the quick selection of suitable machines/sheets.  The material & machine 
type settings, along with Maximum/default sheet size option (from the Standard Sheet tab) and the Minimum 
Sheet Size (from the Machine Limits tab) may be used to filter out machines which are unsuitable for the 
current production job. 

Layout Sheet Assistant 
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Step 1 is geared towards selecting a suitable machine.  Note the four available filters (size, material, rotary, and 
flatbed) beneath the Step 1. Select Machine label. 

• Only show machines upon which this One_Up will fit – will filter out any machine with a machine 
default size smaller than the current design width & height (provided the size of the One_Up may be 
determined).    The filter simply looks for a width & a height in a Cut‐type palette and will be 
automatically applied if a valid cut profile is detected. 

o To demonstrate this feature, use a design with a non‐Cut type profile palette – consider 
running a Standard and swapping the Cut profile palette for palette 0. 

o Start the Layout Sheet Assistant and notice that the first filter is not applied automatically. 

o Switch the profile palette to a Cut‐type and re‐test.  The filter will be automatically applied. 

o Note that if you are working with a multi‐layer project, things may behave in a slightly 
unexpected manner (although this is not new....).   

o If the current One_Up layer has a non‐Cut type profile, but another layer within the drawing 
DOES have a Cut‐type profile, the first filter will be applied and the Layout Creator will open 
up with the valid One_Up design (even through it was not the current layer). 

o Additionally (this test works best when you don’t have a vast selection of machines to pick 
from), run a Corrugated Standard (as an example, pick a Rolled Side Tuck Tray/FEFCO 0426 – 
in B Flute and accept the default settings).     

o Start the Layout Sheet Assistant – make a temporary override to a machine so that the 
Maximum default sheet size is smaller than the One_Up height & width (21” by 12” for 
example). Notice that the first filter is automatically applied and that the modified machine is 
not visible for selection.  Disable the filter and the machine will now be visible. 

• Only show machines that are valid for this material – only machines with a suitable material type and 
suitable calliper limitations (the current material calliper lies between the minimum & maximum 
calliper values for the machine) may be selected.   

• If a Standard material has been used (and the Material MTS are set up correctly),   the presence of 
Material Type and suitable CA values will ensure that this filter is also switched on automatically. 

o To demonstrate this feature (this test also works best when you don’t have a vast selection of 
machines to pick from), again pick a Rolled Side Tuck Tray/FEFCO 0426 – in B Flute and accept 
the default settings. 

o Start the Layout Assistant and make a temporary override to an existing machine MTS by 
setting the Machine Type to Folding Carton only.   

o Notice that the second filter will be automatically applied and that the modified machine is 
not available for selection.  Disable the filter and the machine will now be visible. 
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o Additionally, using the previous scenario, re‐enable the Corrugated Machine Type and set a 
Maximum Caliper value to 1/16th 

o Notice that the second filter is automatically applied and that the modified machine is not 
available for selection.  Disable the filter and the machine will now be visible. 

o Obviously, the tests were carried out using temporary overrides to the Machine/Sheet 
Settings – permanent changes would need to be made within the Master Tool Settings! 

• Only show machines which are rotary – will prevent any Flatbed machines from being selected. 

• Only show machines which are flatbed – will prevent any Rotary machines from being selected. 

• Note that these filters may be combined – therefore you can request a list of machines upon which the 
One_Up will fit, AND machines which are valid for the current One_Up material & calliper AND either 
flatbed OR rotary.   

• As these filters are the first stage in creating a layout, it is important that the existing Machine/Sheet 
Settings MTS are configured correctly! 

• To generate a layout, you need to select and ‘Add’ one or more machines to the Layout Assistant. 

Step 2 is geared towards the selection of either a Stock Sheet or simply using the machine default sizes or 
adding a Custom sheet.  If you have any defined Stock Sheet MTS, they will be available via the From Stock tab. 

Layout Sheet Assistant  Showing Stock Sheet MTS 

 
 
The Custom tab will allow you to generate a custom sheet on‐the‐fly for this specific job. 
 

Layout Sheet Assistant  Custom Sheet Option 
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Step 3 – once you have selected a machine (and optionally a Stock or Custom Sheet), click Add to move these 
items to the Layouts column and click OK to begin creating the layout. 
 
Note that if Site‐Specific Master Tool Settings are being deployed, an additional filtering option is available 
within the Layout Sheet Assistant ‐ to filter by Site.  This will automatically be applied. 
 

Layout Sheet Assistant  Site‐Specific MTS Option ‐ UK 

 
 

Layout Sheet Assistant  Site‐Specific MTS Option ‐ USA 

 
 

Layout Editor – New Tools & Revised Tool Positioning 
 

Layout Editor Showing Layout Toolbar & Enquire Menu 

 
 

The Layout toolbar contains the most significant of the new & repositioned tools.  From left to right, (following 
the Save & Generate Layouts and Cancel & Exit icons), you will find  Show Outside Row & Column, Force Extra 
Row, Force Extra Column, Automatic Spacing & Use Minimum Trim, Centre Horizontally and Centre Vertically.  
Note the presence of an Enquire menu – this gives access to a range of Enquire tools (Distance, Parallel etc). 
Force Extra Row & Force Extra Column should be used when the Show Outside Row & Column tool suggests 
that an extra row or column is feasible without modifying a design too drastically.  These options will allow 
Impact to create an overlapping layout (designs will overlap so that the next row or column will fit right up to 
the edge of the sheet, including any trim values).   
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The Layout Trim tool may then be used to trim sections of the One_Up design to remove the overlapping 
sections – this is done after the layout has been generated.   
Note that Force Extra Row and Force Extra Column are only available if a Fill Sheet type layout is required. 
The Automatic Spacing option is used to reset the layout after the Force Extra Row and/or Column tools have 
been applied and provided an unsatisfactory result.  This option will default to ‘on’ for new installs & upgrades 
to existing Impact installations. 
The Allow Minimum Trim option allows the Use Trim Optimisation options specified for a machine/sheet to be 
applied. 

Trim Optimisation Example 
As an example, create a Standard ECMA A2120 where Length=4 1/16th, Width=2 ½” & Depth=6”.  

ECMA 2120 Main Panels 

 
Modify the Glue Flap allowances to add a flap of ¾”. The material used for this example was 350 FBB (1/64”). 
 

ECMA 2120 Glue Flap Allowances 

 
 
Run the Layout Creator and select the Bobst EXPERTCUT 106LE machine.  Use the default values for width & 
height (41 ¾” x 30”) – do not select a Stock Sheet! 
Try to create a 3 x 3 grid style layout using the Automatic pattern – ensure that the layout is centred 
horizontally.   
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Layout Editor 

 
Notice how the knife‐to‐knife values for the horizontal axis (41 & 9/16”) just exceed the Standard Diecutting 
Area (41 & ¼”).  Notice also that, because the knife‐to‐knife exceeds the Standard Diecutting Area, no machine 
or sheet utilisation figures have been calculated. 
 
Activate the Use Minimum Trim option and notice how the sheet & layout are modified and machine & sheet 
utilisation figures are now present. 

 
Generate the layout & check the positioning of the designs on the sheet. The designs have been allowed to 
encroach into the trim area, to make use of the Maximum Diecutting Area of the machine/sheet. 
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Force Extra Row/Column & Layout Trim Example 
Run the FCA 1010 (Overlapping Skillet) Standard where Length = 4 ½”, Width = 5 ½” and Depth = 4 3/4“. 
 

FCA 1010 Main Panels 

 
Modify the Skillet Allowances by ticking the Fillets Required option. 
 

FCA 1010 Skillet Allowances 

 
 

Start the Layout Creator and use the Bobst MASTERCUT 106 PER and BOBST MASTERCUT 145 PER machines 
(do not use any Stock Sheets!).  

Layout Sheet Assistant 
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Click OK to access the Layout Creator, select the Fill Sheet mode and apply the End to End layout pattern.  
Ensure that Show Outside Row & Column is enabled. It should become apparent that with a little design 
trimming, an extra row can be added to the Bobst MASTERTCUT 106 PER, but there is no such opportunity for 
the Bobst MASTERCUT 145 PER 
 

Fill Sheet on Bobst MASTERCUT 106 PER 

 
 

Fill Sheet on Bobst MASTERCUT 145 PER 

 
 

Uncheck the Bobst MASTERCUT 145 PER and apply the Force Extra Row tool.  This will create an overlapping 
layout for the Bobst MASTERCUT 106 PER. 
 

Preview of Overlapping Layout on Bobst MASTERCUT 106 PER 
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Save & generate this layout. 
Overlapping Layout on Bobst MASTERCUT 106 PER 

 
 
Run the Utilities>Layouts>Trim One_Up tool.  Follow the Help Tips and select One_Up A3 as the One_Up to be 
trimmed.  When prompted, create a marquee around the overlapping geometry as shown below. 
 

A3 Design with Area to Trim 

 
Following the second click, the geometry will be automatically trimmed. 
 

A3 Design with Trimmed Area 

 
Repeat the process for the second area to be trimmed.  Note that, as the Layout Trim tool is still running, you do 
not need to restart the tool! 
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A3 Design with Area to Trim 

 
 

A3 Design with Trimmed Area 

 
Switch to the One_Up layer to see the modifications to the geometry. 
 

Trimmed A3 Design 

 
Use the Edit>Undo tool to reverse the changes you made and return to the overlapping layout.  Re‐run the 
Utilities>Layouts>Trim Layout tool ad this time, use Ctrl + Click to select design A3 as the design you wish to 
keep.  Trim away the same sections of geometry and check the One_Up layer.  You should notice a significantly 
different result! 
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A3 Design with Trimmed Area (Alternative) 

 
 

Trimmed A3 Design (Alternative) 

 
 
 

Quick Layout Tool 
The Quick Layout Tool utilises the current Machine/Sheet, Layout Pattern and Palettes Master Tool Settings to 
allow users to generate a simple layout, quickly & effectively.  As the MTS used by this tool have already been 
discussed, this section of the document will focus upon the operation of the tool itself. 
The tool can be accessed via the Utilities>Layouts menu and displays 4 Edit Bar options and an Accept button: 
 

Default Edit Bar Options for Quick Layout Tool 

 
The Sheet, Pattern & Palettes lists simply access the existing MTS and also allow for a temporary override. 
If the Fill Sheet option is unchecked, the user may specify a Number (of designs) in X and a Number (of designs) 
in Y. 

Expanded Edit Bar Options for Quick Layout Tool 

 
A layout will be generated in accordance with the Edit Bar options.  Running the Quick Layout tool on an existing 
layout layer will simply allow the user to replace that layer.  The tool will not generate an additional layer! 
Layouts generated by the Quick Layout tool may be edited in the Layout Creator. 



 

Impact 2010 
3D and TruView 
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What’s New? 
 
Impact is now capable of realistic rendering of foiling, varnished & varnish free areas.     
All lighting & shadow effects are now applied in real‐time (you do not need to use the Quick Preview Render in 
order to check the lighting & shadow effects prior to creating a snapshot or a movie).  
Image‐based lighting & reflection effects are now possible via TruViewEnvironments (TVE files). 
The new 3D Trim tool allows a folding model to be trimmed against another folding model or a 3D object to 
create a cut out in both the 3D and 2D layers.   
Improved texture quality within a 3D scene has been added via the texture quality controls for artwork within 
the 3D Wizard.   
 

Master Template Additions – New Palettes & Palette Modifications 
 
Impact 2010 has two methods for creating varnishing & foiling effects ‐ via the use of geometry & palettes and 
via the use of image files & masks. The former method relies upon the new 3D Palette Settings options (tabs for 
Non‐Print, Foiling and Acetates) which allow you to select an Impact palette to generate the relevant effects. 
Whilst you could select any palette to generate the required effects (provided you ensure that the relevant 
palette is selected on the relevant 3D Palette Settings tab), it is strongly advised that new dedicated palettes 
should be created for Foiling & Acetate geometry.   
In addition, palette‐based varnishing relies on a suitable palette being assigned to a Non‐Print tab of the 3D 
Palette Settings or the selection of a suitable palette Non‐Print palette TYPE.  A new palette TYPE has been 
created for Impact 2010 (TYPE Non‐print) and any existing non‐print palettes should be updated to use this new 
type ‐ currently, Non‐print palettes are assigned TYPE Other. 
The new palettes (Foiling and Acetate) need to be added to the Master Template (and any other drawing 
templates being used).  The name of the palette is not important (though it would be logical to name the 
palettes sensibly), the palette TYPE should be OTHER.  The display options may be left for the user to specify. 
To add the new palettes to the Master Template, Simply click File>Open>Master Template (end users may not 
have the required privileges to do this, the SUPPORT or ADMIN account should be used).  The Master Template 
will open (by default) on the Palettes branch of the Design Options. 
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Master Template Design Options 

 
Simply click the ADD button to add a new palette.  As mentioned above, Acetate & Foil palettes should be set to 
TYPE OTHER. 
 

Acetate Palette Attributes ‐ General 
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Acetate Palette Attributes ‐ Display 

 
 

Foil Palette Attributes ‐ General 
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Foil Palette Attributes ‐ Display 

 
 
Non‐print Palette Attributes ‐ General 
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Non‐print Palette Attributes ‐ Display 

 
Ensure that you Save the Master Template (and any other relevant templates) when you have added/modified 
the settings: 
 

Master Template – Save Changes 

 
 

Note: that the new palettes are all set to TYPE OTHER – for this reason, it is vital that within any 3D Palette 
settings, the selection of the ‘Other’ type on the ‘Other’ tab is unticked! 
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3D MTS – Palette Options ‐ New Settings and Modifications  
The 3D Palette Options MTS feature new tabs for Non‐Print, Foiling and Acetates.  For simple geometry‐based 
foiling, suitable palettes must be selected (for advanced foiling, masking images are used).   
For the release of Impact 2010, a new database has been prepared with suitable palettes already added.  For 
Impact 2010 upgrades, as mentioned previously, it is recommended that new palettes are created (type Other 
for Foiling and Acetate) and the new palette type Non print should be assigned to any non‐print palettes. 

 
 

Example 3D Palette Options MTS – Non Print tab 
Rather than specifying a number of palettes (to act as varnish masks), I have simply selected the Non print TYPE 
(therefore all palettes of this type can be used as varnish masks) under the Non Print tab. 
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Example 3D Palette Options MTS – Foil tab 

The Foil palette is selected under the Foiling tab. 

 
 

Example 3D Palette Options MTS – Acetates tab 
The Acetate palette is selected under the Acetates tab. 
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Example 3D Palette Options MTS – Other tab 
Note that the Other palette type is not enabled under the Other tab.  Doing so will prevent any Other type 
palettes from being selected under the Foiling & Non Print tabs – and that means no foiling or varnish effects! 

 
 
 

3D MTS – Materials & Board Settings ‐ New Settings and Modifications 
The Materials MTS also have a new Texture Resolution & Direction controls.  The latter allows the flute/grain 
within a 3D scene to reflect the flute/grain settings within the associated 2D layer.  Switching the flute/grain in 
2D and updating the 3D model will now update the direction of the textures within the 3D scene. 
 

3D Material Properties MTS 

 
 
The Board Settings MTS now feature a dynamic preview (note the preview controls under the preview 
window!).   
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3D Board Settings MTS 

 
 
 

 

3D MTS – Varnish & Foil Settings 
New 3D MTS folders have been created for Varnish and Foil settings.  Default settings have been added to the 
Impact 2010 Release Database and these can be distributed for Impact 2010 upgrades. 
The Varnish settings contain entry fields for Brightness & Sharpness plus a dynamic preview. 
The Brightness controls how bright the material will appear whilst the Sharpness option controls the sharpness 
of reflected images. 

Varnish Properties MTS 

 
Although materials can have reflective properties, you can optionally apply a Varnish MTS to a folding model.  
The Varnish setting will be applied to the surface of a model except for areas defined by a closed‐path of a Non‐
Print palette.  This allows for a realistic model containing both matt & glossy areas. 
The Foil settings contain entry fields for Colours and Reflections, Texture controls (resolution & direction), a 
dynamic preview and a Textures tab. 
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Foil Properties MTS 

 
 

 
The Textures tab allows the optional use of base, gloss & texture maps to create photo‐realistic materials.   
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Legacy MTS 
Existing board settings will be stripped of their assigned materials during the Impact 2010 upgrade process. This 
is because we now have new material types (for Board, Edge, Legacy, Standard & Foil materials) – and these 
types did not exist prior to Impact 2010.  It is not possible to retrospectively assign material types to existing 
materials automatically, and so upgrading users wishing to make use of existing materials will need to modify 
their existing settings. 
      Example ‘Legacy’ Corrugated Board Setting in Impact 2010  

 
 

Note: the material assignments on the screenshot above   <None> for each item. 
 
Taking the Corrugated B Flute as an example, this is typically made up of Corrugated Liner (Print Face), 
Corrugated Liner (Die Face) and Single Wall Corrugated (for the fluted edging).  These materials will default to 
Legacy types following an Impact 2010 upgrade.  Looking at the Corrugated Liner (Die Face), you can see the 
material type is set to Legacy – also note the Sharpness value – this will need re‐setting to a sensible value! 
 

Example Legacy Material in Impact 2010 

 
 



 

    
Impact 2010 3D and TruView  © Copyright 2010  Arden Software North America  P a g e   14 | 34 

 

 
 
Therefore, if an upgrading Impact user wishes to use the existing Corrugated B Flute Board Setting, the 
underlying materials must be reclassified.  In the case of the Corrugated Liner (Print Face) and Corrugated Liner 
(Die Face), these materials need to be assigned to the Board category, whilst Single Wall Corrugated would 
need to be assigned to the Edges category.  Once this has been done, the existing Corrugated B Flute setting 
will display as follows – note that the material assignments have been updated: 
 

Reassigned Legacy Corrugated Board Setting in Impact 2010 

 
Note that the high reflectivity is due to the Reflection>Sharpness value for the individual materials – this value 
can be modified as mentioned above. 

3D Visibility  
One potential gotcha for upgrading customers is that, within the 3D Visibility settings, the mip‐mapping option 
must be enabled to get realistic results. 

 
For new installs with the Impact 2010 Release db, this will be enabled by default. 
If this option is not enabled (for customers upgrading to Impact 2010 from earlier releases), materials will look 
over‐shiny (in both previews and 3D canvases) and the blur feature for the 3D background will not have any 
effect!  For upgrading customers, ensure that this option is switched on – and double check any 3D Scene 
templates also! 
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Simple Varnish Example 
Create some simple, closed‐profile geometry in a Cut type palette.  Within the closed profile, add a closed‐
profile Non‐Print area.  Check that your Non‐Print palette is defined as a TYPE Non print!  Run the 3D Viewer – 
select any material and select a suitable Varnish setting (Gloss ‐ High should give the most obvious result).  Do 
not activate the 3D Wizard at this point! 
 
        Cut & Non print geometry 

 
 

Resultant 3D Scene 

 
The closed‐profile Non print area did not receive the high‐gloss varnish coating.  An interesting effect can be 
created by using the Rotate View tool in conjunction with the Ctrl key.  This allows you to rotate the 
environment around the 3d model – allowing you to observe any reflections (caused by lights or other 
environmental attributes) on the glossy surface.  Although this effect may be observed within a simple scene 
like the example above, the effect is most prominent when combined with foiling effects & TruView 
Environments. 
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Typical Varnish Example 
Firstly, ensure that the Non print palette is configured as a Non print Type. Run an Impact Standard such as a 
Folding Carton/ECMA FC0505 (Captain End Load Skillet). Accept the default material & size options and ensure 
that you tick the Apply Non Print Hatching option (the Non print setting should suffice) on the Geometry 
Creation page. 
        FC0505 Geometry Creation Page 

 
 

Resultant Geometry 

 
Run the 3D Viewer tool, select a suitable material (such as Folding Box Board – check the material thickness 
1/64”!) and select the Gloss‐High varnish setting from the edit bar. Do not activate the 3D Wizard and pick the 
base point as indicated in the screenshot above.  Once the 3D scene has been created, flatten the model and 
rotate it about the x‐axis by 180 degrees 
   

Resultant 3D Scene 

 
Again, the Non print areas have not received the high‐gloss varnish coating.  The use of Rotate View + Ctrl 
should allow you to observe the reflective surface of the model.  Notice the lighting effects in the following 
screenshot. 
 



 

    
Impact 2010 3D and TruView  © Copyright 2010  Arden Software North America  P a g e   17 | 34 

 

Resultant 3D Scene – with Environment Rotation 

 
 

Simple (Geometry‐Based) Foiling Example 
Run an Impact Standard such as a Folding Carton/ECMA FC0505 (Captain End Load Skillet). Accept the default 
material & size options and ensure that you tick the Apply Non Print Hatching option (the Non print setting 
should suffice) on the Geometry Creation page, if you wish to create varnish effects.  Create some closed‐
profile geometry (or alternatively, text) to represent foiling, in a suitable palette. In the example below, the text 
was created in Monotype Corsiva (height 5/16”).  If you do use text, remember to change the palette to Foil! 
 

Cut & Foil geometry 

 
Run the 3D Viewer tool – select the Folding Box Board material (again, check that the material thickness is 
1/64”), select the Gloss‐High varnish setting and the Hazy Gold foil setting.  Pick the base point as indicated 
above. Once the 3D scene has been created, flatten the model and rotate it about the x‐axis by 180 degrees. 

 
Resultant 3D Scene 

 
Use the Rotate View + Ctrl to simulate the environment rotating around the model.  Notice how the light is 
reflected by the foiling. 
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Foiling Modification Example – Increased Sharpness 
Return to the 2D layer and re‐run the 3D Viewer tool.  Make a temporary override to one of the foiling settings.  
Modify the Sharpness control to 100% and re‐create the 3D model. 
 

Resultant 3D Scene 

 
Notice the increase in reflectivity – this is especially apparent if you use the Rotate View + Ctrl feature to rotate 
the environment about the model. In the screenshot above, you can clearly see the highlights reflected in the 
Simple text.  The example on the following page shows the same model with a TruView Environment (TVE) 
applied as a reflection map.  The reflections are clearly visible in the Foiling Example text. 
 

3D Scene with Reflection Map 

 
The screenshot on the following page shows a solid block of foiling, with a high sharpness setting.  The 
increased foiling area makes for a more obvious reflection of the TruView Environment applied to the scene  
(one of the driving forces behind the development of the TVE functionality was to allow packaging to reflect 
tyical surroundings such as shop interiors etc). 
 

3D Scene with Reflection Map 
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Complex (Image‐Based) Foiling Example 
Advanced effects may be created by the use of suitable images files which may be loaded into the 3D Wizard, 
for use as foiling masks.  Essentially, these masks must be a monochrome image, where white areas will receive 
foiling and black areas will not.  Adobe Photoshop and other applications such as Paint.Net may be used to 
quickly create monochrome image files.  The image below will be used as a foiling mask. 
 
          Example Foiling Mask 

 
Import the example project, run the 3D Viewer tool and this time, tick the 3D Wizard option on the edit bar.  
Select the Carton – Silk Board material (check that the material thickness is 1/64”!), pick the Gloss‐High varnish 
setting and the any foil setting (this choice will be need to be re‐selected within the Wizard!).  Select the base 
point within the bar‐coded area as shown in the following screenshot. 
 

Example Foiling Project 

 
Once the 3D Wizard has launched, navigate to the Foiling page and from the context menu within the Foil 
Layers area, pick the Add Layer option.  Select the Aubere Paris ‐ Chique Eau De Toilette Foiling 2.png file and 
select the Hazy Gold foil setting.   
 

3D Wizard – Foiling Page 

 
Click OK and wait for the preview to update. 
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3D Wizard – Updated Preview 

 
Click Next to progress to the Preview page. 

 
3D Wizard – Preview Page 

 
The preview may be modified in real‐time and the Rotate View + Ctrl feature may also be used within the 
preview pane.  Click Next and Finish to create the 3D model. 
 

Resultant 3D Model 

 
Up to three different foil settings may be used within the same drawing – as well as the foil setting selection on 
the edit bar, you can apply multiple foiling maps within the 3D Wizard! 
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Complex (Image‐Based) Varnishing Example 
In the same way that masking images may be used to provide complex effects, the same technique may be 
applied to creating complex varnishing.  Monochrome images may be applied via the 3D Wizard to apply 
specific varnish settings to specific parts of a model.  White areas will receive a varnish mask, whilst black areas 
will not.  Another similarity to the foiling technique is that multiple maps may be added to the 3D Wizard to 
create areas with different varnish characteristics – for example, a single model may have a matt varnish setting 
applied to the entire board, but high‐gloss varnish applied to a company logo and a mid‐gloss varnish applied to 
a product image. 

Varnish Mask 1 

 
 

Varnish Mask 2 

 
 

The images may be loaded into the 3D Wizard at the Varnishing page. 
Using the same source project as before, select & delete the graphic from the 2D layer and re‐run the 3D Wizard 
(pick the Carton – Silk Board Material, pick the Matt Varnish setting and this time, do not select a Foil (pick the 
None setting)! Within the 3D Wizard, navigate to the Varnishing page.  From the context menu within Varnish 
Layers pick the Add Layer option.  Select the Aubere Paris ‐ Chique Eau De Toilette Varnish 1.png file and 
assign the Gloss‐High setting.   

Apply Varnish 1 Layer 

 
Repeat the process and assign the Aubere Paris ‐ Chique Eau De Toilette Varnish 2.png file to the Gloss‐
Medium setting. 
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Apply Varnish 2 Layer 

 
 

Varnish Page with Both Layers Applied 

 
Navigate to the Preview page. 

 
3D Wizard – Preview Page 

 
Click Next and Finish to create the 3D model. 
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Resultant 3D Model 
 

 
A Matt finish has been applied to the overall design, with High & Medium Gloss varnish settings applied to the 
masked areas. 
 

Window Patches & Acetates  
Create some simple, closed‐profile geometry in a Cut type palette.  Within the closed profile, add a closed‐
profile cut‐out window.  Enclose the cut‐out window with a closed‐profile Acetate area.  Run the 3D Viewer – 
select any material and Varnish setting.  Do not activate the 3D Wizard at this point.  Ensure that the selected 
3D Palette setting shows the Acetate palette selected under the Acetate tab! 
         

Cut & Acetate Geometry 

 
Resultant 3D Model 

 
The acetate window is automatically created. 
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Typical Example 
Run an Impact Standard such as a Folding Carton/ECMA FC0505 (Captain End Load Skillet). Accept the default 
material & size options.  Add a cut‐out window as shown below and add an Acetate window around the cut‐out.  
Run the 3D Viewer – select any material and Varnish setting.  Do not activate the 3D Wizard at this point.  
Ensure that the selected 3D Palette setting shows the Acetate palette selected under the Acetate tab! Pick the 
base point as shown below. 
 

Cut & Acetate Geometry 

 
Resultant 3D Model 

 
 
 

Corner Example 
Window patches are also able to fold ‐ typically around corners.  Simply add suitable geometry where the patch 
would be expected to fold.  Taking the last project as an example, modify the cut‐out window and the acetate 
patch as follows.  Update the 3D layer to confirm that the window behaves as expected.  Remember to trim the 
Crease geometry and add the extra Acetate geometry! 
 

Cut & Crease Geometry 
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Cut & Acetate Geometry 
 

 
 

Resultant 3D Model 

 
Fold the model and user the Rotate View + Ctrl function to rotate the environment about the model. 

 
Resultant 3D Model 
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Complex Example 
Run the ECMA C4020 Standard – accept the default material & sizes.  Add a suitable cut‐out window & Acetate 
as follows.  

Cut & Crease Geometry 

 
 

Cut & Acetate Geometry 

 
Run the 3D Viewer – select any suitable material.  Do not activate the 3D Wizard. Pick the base point as shown.  
 
Fold the model and user the Rotate View + Ctrl function to rotate the environment about the model. 
 

Resultant 3D Model 
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3D Visibility Modifications – Studio Wall 
A Studio Wall background option has been added to the Floor options.  The wall may be sized & texture 
mapped and can also reflect TruView environments. 
 

3D Visibility ‐ Floor 

 
 

Resultant 3D Scene 

 
 

3D Visibility Modifications – Silhouettes (Gobos) 
Light sources may now cast advanced shadows formed by image files, via the new Silhouette option. 

Light Properties 
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Resultant 3D Scene 

 
 

TruView Environments 
One of the major developments for Impact 2010 3D functionality was the creation & application of TruView 
environments.  Impact 2010 has the ability to display a 3D ‘wrap‐around’ background for a 3D scene – as 
opposed to a 2D image, plain colour or colour gradient. Materials may be configured to reflect these 
environments to simulate different material types (glass, metal, paper, plastic etc).  Furthermore, the TruView 
environments themselves can provide ‘image‐based’ lighting effects – whereby the lighting level & colouration 
of the environment can light the 3D scene.   
A description of how to create TruView environments is beyond the scope of this document, however Arden 
Software will be creating & distributing several default environments for distribution.  The environments 
themselves (in the form of *.TVE files) need to be placed within the Plugins sub‐folder of the ‘C:\Program 
files\Arden Software Ltd\Impact 6’ folder.  After the files have been placed in the named folder, a re‐start of 
Impact will be required in order for the environment files to register. 
 
TruView Environment as Reflection Map Only 
Display the 3D Background controls via the 3D context menu.  Specify a 2D background as follows and specify 
the Store Interior – Deli as a reflection map. 
 

3D Environment Options 
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3D Background Options 

 
 
Resultant 3D Scene 

The screenshot below shows the combined results of a TruView environment (Store Interior – Deli) with a 2D 
background providing a colour gradient (white & grey, vertical gradient) background. 

 
The Acetate window is reflecting the Store Interior – Deli environment, whilst the environment is providing the 

variations in lighting over the surface of the model. 
 

TruView Environment as Scene Background and Reflection Map 
Keep the Store Interior – Deli as a reflection map, but change the Background and select a 3D Background.  
Select the Store Interior – Deli and enable a Blur of 7%. 
 

3D Background Options 
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Resultant 3D Scene 

 
 

Combining Reflective Materials (such as Foiling) with TruView Environments 
Run the FC0505 ‐ Captain End Load Skillet Standard – accept the default materials & sizes.  Modify the geometry 
to add cut‐out windows & Acetate patches as shown below.  Add some additional foiling entities (geometry or 
text). 

 
Run the 3D Viewer tool – select a suitable material, the Gloss‐High Varnish Setting and pick any Foil Setting 
(override the setting to increase the sharpness).  Pick the base point as indicated. 
As with the previous exercise, within the 3D scene keep the Store Interior – Deli as a reflection map, select the 
Store Interior – Deli as a 3D Background and enable a Blur of 20%. 
 

Resultant 3D Scenes 
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Resultant 3D Scenes (continued) 
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3D Trim Tool 
This tool allows a folding model to be trimmed against another folding model or 3D object, in order to modify 
both the 2D & 3D geometry.  Note that pre‐selecting objects will allow the tool to run slightly differently.  
Essentially, you select the folding model you wish to trim, followed by the object (or folding model) you wish to 
trim against.   
Edit bar options are Palette (for specifying the palette of the new geometry), Auto Update 3D (self‐
explanatory), Allowance (the resultant cut‐out geometry may be required to be larger than the object being 
trimmed against) and Sharp Corners (self‐explanatory).  
Ensure that the palette settings on the edit bar display a cut‐type palette when running this tool! 
 

Example Project for 3D Trim tool 

 
Run the tool and follow the edit bar prompts.  With no selection made, the first prompt requests you to identify 
the model to be trimmed (eg the upper or lower board), whilst the second prompt requests that you select the 
object to trim against (eg one of the items in the array). 
Note that if the original 3D scene has been created with the 3D Wizard tool, the tool will be reactivated when 
using the 3D trim tool. 
 
                    Geometry page of the 3D Wizard 
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Resultant geometry 

 
 

Reactivate the tool and trim the upper board 

 
 

Resultant geometry 
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3D Wizard – Improved Artwork Quality 
Within the 3D Wizard, you can choose the texture quality for the 3D scene.  Low (1024 pixels per face), Medium 
(2048 pixels per face) & High (4096 pixels per face). 
 

3D Wizard – Texture Quality Options 

 
 
For Impact versions prior 2010, the max texture size was locked to 1024 pixels per face.  If the quality of the 
graphics in the 3D scene was not acceptable, you could swap‐out the embedded artwork in the 3D layer for the 
original 2D artwork.  This gave significant improvements and worked correctly provided the artwork was able to 
be stretched over the drawing.  With Impact 2010, you can now utilise 4096 pixels per face – and the texture 
swap‐out is still an option if you need better results. 
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